Controller’s Office
Rochester Institute of Technology

Oracle Training: Performing Inquiries and Requesting Reports in the Oracle Applications
# Table of Contents

**Introduction**

Lesson 1: Perform an Account Inquiry

Lesson 2: Request a FSG Report using Publish FSG Report program

Lesson 3: Request a FSG Report using Run Financial Statement Generator program

Lesson 4: Print a FSG Report on a Networked Printer

Lesson 5: Request and Print the RIT Account Analysis- Subledger Report

Lesson 6: Request and Print the RIT Encumbrance Detail Report

**Appendix 1:** Oracle Standard Reports (Chart)
- Item #1: How to Default Your Printer Name
- Item #2: Reprint Function
- Item #3: How to Schedule a Report

**Appendix II:** Additional Reference Information (Controllers Website):
- MFA (MULTI-FACTOR AUTHENTICATION)
- Month-End Closing Schedule
- Oracle Financial Applications FAQs
- Oracle Training
Introduction

RIT employees are able to request financial information for their departments and projects through the Oracle Financial applications from their RIT issued computers.

Objectives
You will be able to use the general ledger to:

• Perform an on-line account inquiry
• Drill down to journal entry, accounts payable or accounts receivable subledger detail
• Request and print FSG (custom) reports (department or project statements)
• Request and print Oracle standard reports (detail reports)
• Send an e-mail notification informing another user that a report has been run
• Schedule a request (Appendix)
• Reprint function (Appendix)
• Default printer name (Appendix)

Advantages of the Oracle Financial Applications

• Timely access to financial information
• On-line access to transactions
• Ability to request and access reports when needed
• More control over budget and financial activity

Accounting Procedures

Department and project managers or staff assistants monitor their actual expenditures as compared to their budgets and review transactions that occur in the general ledger. Various custom and standard reports are available within Oracle to assist departments with this task. As an Oracle user, you may perform account inquires to check an account balance or request reports on-line in the Oracle General Ledger and print them on your networked printer.

NOTE: In order to perform the functions taught in this course, you must have access to a “RIT –GL- Report & Inquiry” responsibility in the Oracle General Ledger. After attending this class, complete the “Oracle Financial Applications Access Request Form” found on the RIT Controller’s website. Email the completed form to the Accounting Operations Senior Staff Accountant/Outreach Specialist for processing. Once received, it will be reviewed. If approved, a work request will be submitted to the ITS Data Center for processing. The user and supervisor will be copied on the work request. You will receive a notice as soon as the ticket is opened and again when it is closed. You will then have access to your new responsibility(s).

If, after taking this course, you have further questions about performing account inquiries or requesting and printing reports, please contact Accounting Operations at ext. 5-2237, or send an e-mail to acctg@rit.edu.
Lesson 1: Perform an Account Inquiry

The account inquiry function permits you to call up and view actual, budget, and encumbrance account balances for any of your 24-digit accounts. Account balance information changes throughout the month and is available to you on-line as soon as transactions are posted to the general ledger.

Objective:
At the end of this lesson, you will be able to perform an actual on-line account inquiry in the Oracle RIT General Ledger application.

Directions: Perform an On-line Inquiry
- Log onto the system now. All of the responsibilities assigned to you appear on your home page.
- From your list of responsibilities select the “RIT – GL – COS RPT & INQ – 67000-67099” responsibility.

NOTE: In order to access functions assigned to another responsibility, you must select that specific responsibility on the Responsibilities screen.
• From the “Inquiry” menu listed to the right of the list of responsibilities, click on “Account”. (The list on the right side are the Functions contained within the Responsibility).

![RIT Screen]

• The Navigator – RIT – GL – CO RPT & INQ – 67000-67099 screen will appear first. The Account Inquiry (RIT) window will open automatically on top of your Navigator screen.

• The Account Inquiry (RIT) form is used to access information about a specific 24-digit account number or a range of accounts within the user’s responsibility for a specified period.
- The Ledger Name and Currency will always be “RIT” and “USD”
- Press the Tab key to move the cursor to the “From” field in the “Accounting Periods” section of the screen.
- Click once on the LOV field to the right of the “From” field.

![Account Inquiry (RIT)](image)

- Scroll down to find “JUN-15” in the “From Periods” list of values.
- Click once on “JUN-15”
- Click once on the “OK” button.

![Find Period](image)

- The same period will populate both the “From” and “To” fields.

**NOTE:** You can inquire into an accounting period that spans several months by entering the desired range in the “From” and “To” fields.

- Press the Tab key once and see that there is a dotted outline box around the Currency “Type” field. This is preset continue.

- Press the Tab key once you will see there is a dotted outline box around the “Entered” field. There is no data in this field. This is preset continue.

- Press the Tab key once.
There are three Balance Types to choose from: Actual, Budget and Encumbrance. In this class, we will cover the process for reviewing an Actual balance, since this is the option used most frequently. A brief summary of steps to follow in order to view a Budget balance and/or an Encumbrance balance is provided below. For more information contact Accounting Operations email: acctg@rit.edu ext. 5-2237.

**Actual Balance**: The amount expended on a particular account line, for the selected period, at the time you are making your inquiry.

**Budget Balance**: The amount of funds budgeted on a particular account line at the time you are making your inquiry.

To make a Budget Inquiry, under Primary Balance Type select “Budget”. The cursor will automatically move to the blank “Budget” field. Use the LOV to the right of the “Budget” field to select the appropriate budget organization from the list of values that appears. Highlight your choice, click once on the “OK” button.

**Encumbrance Balance**: The amount of funds reserved for future expenditures, at the time you are making your inquiry. There are 4 encumbrance types that RIT currently uses.

- **Commitment**: A commitment encumbrance entry is made automatically when a purchase requisition is approved. It is reversed when the requisition becomes a purchase order.
- **Obligation**: An obligation encumbrance entry is made automatically when the purchase order is approved. It is reversed when the purchase order is either matched to an invoice or the purchase order is cancelled.
• Invoice: An invoice encumbrance entry is made when an invoice is matched against a purchase order at the time the invoice is entered in Accounts Payable. It is reversed when the invoice is paid.

• Manual: An encumbrance entry created by the user within the Oracle Financial Applications. When the actual expense is charged to the general ledger the user must prepare another entry to reverse the encumbrance entry.

To make an Encumbrance Inquiry, under Primary Balance Type select “Encumbrance”. The cursor will automatically move to the blank “Encumbrance Type” field. Use the LOV to the right of the “Encumbrance Type” field to select the appropriate encumbrance type from the list of values that appears. Highlight your choice, and click once on the “OK” button.

• The system defaults to Primary Balance Type “Actual” Notice a small dot appears inside the radio button beside the word meaning this option is selected. You are now ready to enter the account number for your inquiry.

• Press the Tab key three times to skip over the Factor and Summary Template fields, to arrive at the next field called “Accounts”.

• Enter the 24-digit account number(s) by segment into the Find Accounts screen pop-up window. Enter each segment of the account number into a blank field on this screen. Notice that the system automatically repeats the entry under the High column. To reach the next blank category field, press the Tab key.
• Enter the following information under the Low column in the Find Accounts screen:
  - Entity: “01”
  - Department: “67000”
  - Object: “73150”
  - Expense Category: “25”
  - Project: “00000”
  - Program: “00000”

• Click on the “OK” button.

• The account number now appears in the “Account” field on the Account Inquiry screen.

You are now ready to view the balance for the account number you just entered.

NOTE: You may inquire on a range of account numbers by entering the appropriate values in the Low and High columns. However you can only see what the security rule for your responsibility allows you to see.

Lesson 1A: Show Balances

The Show Balances feature displays the Period-To-Date (PTD) and Year-To-Date (YTD) balances for the account number and period range you just entered on the Account Inquiry screen.

Objective:
At the end of this lesson, you will be able to call up and view an actual account balance, select additional fields to view and print the screen at your desktop printer.
Directions: View Actual Account Balance

- Click once on the **Show Balances** button.

A new Detail Balances (RIT) screen appears with the account number located in the title bar. The PTD (period-to-date) balance and the YTD (year-to-date) balance for the selected account number and period now appear on the screen.

**NOTE:** To inquire on the total expenditures for an RIT operating account, view YTD (year-to-date) information. To inquire on the total expenditures for NTID operating accounts or Grant accounts (project #’s 3XXXX, CXXXX), view PJTD (project-to-date) information. Contact Accounting acctg@rit.edu, ext. 5-2237 to obtain more information about this process.

If you would like to determine the PJTD (project-to-date) balance for this account, click once on the Folder Tools icon located on the Toolbar.

- Click once on the Folder Tools icon on your toolbar.
• Click once on the Show Field icon within the Folder Tools screen.

• Click once on “PJTD”.
• Click once on the “OK” button.

A PJTD column now appears on the screen after the YTD column. You can expand the present view even further by using the scroll bar at the bottom of the screen or return to the original view, and click once on the Hide Field icon in the Folder Tools screen.
• Click once on the Hide Field icon. The screen returns to its original view.

• Click once on the close box on the Folder Tools icon.
You are now ready to review the individual journal entries that make up this account’s PTD balance.

**Lesson 1B: View Journal Entry Details – Manual Journal Entries**

At this point in your inquiry, you may want to view the individual journal entries that make up the balance on the account. To do this, we will use another option on the Account Inquiry screen.

**Objective:**
At the end of this lesson, you will be able to call up and view journal detail for a manual journal entry.

**Directions: View a Journal Entry**

- In the Detail Balances (RIT) screen, place your cursor on the line that you would like to select.
- Click once on the “Journal Details” button.
“Batch” column: the “Batch” names for all manual journal entries are formatted according to the standard RIT naming convention.

“Journal” column: each journal must have a unique name. Repeating the batch name is acceptable however you may choose to be more specific in designating your name. “Source” see below.

“Entered Currency” transactions will always be reported in US Dollars only.

“Line” is the position of that specific journal entry which is part of that specific batch.

“Entered Debit” and “Entered Credit” will depend on the type of transaction.

Important

Refer to the “Source” column. In this example all of these journal entries were prepared by a manual process. “Manual” means a person with journal entry responsibility prepared a journal entry directly in the application. “ACTIVE PAY” these entries are a part of a large pool of data that was imported from another database into the Oracle General Ledger. “ANAPOLI” is also the same process as “Manual” entries however the preparer has a unique identifier. We will cover subledger journal entries a little later in the class.

To obtain more information for all journal entries prepared by manual sources, click on the “Show Full Journal” button. In order to return to the previous screen, click on the “Detail Balances” button. You want to know more about the first journal entry. Place your cursor in the first row and clicks on the “Show Full Journal” button.
• Place your cursor in the first row.
• Click on the “Show Full Journal” button.

**Notice the “Line” number for this transaction is 20 (see below)**

![Image of Journal Entry]

**Notice the “Line” number is 20 for this transaction (see below)**

![Image of Journal Entry Details]

**NOTE:** When viewing Journal details through Account Inquiry you will only be able to see the journal entry lines using account numbers that you have access to through your Reporting & Inquiry responsibility.
You want to know which Oracle user originally entered the journal entry. Click on “Help” located on the Menu bar at the top of the screen and then click on “Record History”.

- Click once on “Help” on the menu bar at the top of the screen.
- Click once on “Record History”.

You are able to view more information about the journal entry, including the Oracle user id of the individual who created it as well as the date it was created. You can also see when it was updated, and by whom. If you do not recognize the user name contact Accounting Operations at acctg@rit.edu ext. 5-2237.

- Click on the “OK” button close out of this window.

You are done reviewing this journal entry. Close the Journals (RIT) - 630DAC0701-01 screen by clicking on the close button in the upper right corner of the screen.

- Click on the close button in the upper right hand corner of the screen.
You are done reviewing the journal entries for 01.67000.73150.25.00000.00000 Period: JUN-15. Click on the button in the upper right corner of the screen.

- You are now back at the Navigator located in the application (not in your homepage). Both Navigators will take you to your desired responsibility or function.

Lesson 1C: View Journal Entry Details – Subledger Journal Entries

Journal batches generated from Accounts Payables or Procurement Services will have a source of “Payables”. Journal batches generated from Accounts Receivables will have a source of “Receivables” In order to view more information on Payables, Procurement Services, or Receivables batches you would click on the “Drilldown” button in the Journals window.

Objective: At the end of this lesson you will be able to drilldown on a subledger entry processed by Accounts Payables.

- From the Navigator select “Inquiry” then either click on the word or click on the “Open” button on the lower right corner of the window.
- The “Account” function will be highlighted. Either click on the word or click on the “Open” button on the lower right corner of the window.
The Account Inquiry (RIT) window will open automatically on top of your Navigator screen.

Since the subledger information provides detail about a purchase order and the payment of those goods and services, we will review a transaction created by a purchase order and subsequently paid to the vendor by Accounts Payables once the goods were received and the invoice was matched to the PO.
• In the “Account Inquiry” window, change the period to **MAR-16**

![Account Inquiry Window]

• In the “Accounts” section, enter the following information in the “Find Accounts” window and click on the “OK” button. (**NOTE:** Capital equipment must be purchased using a PO#). The capital equipment project number for all RIT operating accounts is #84200.

![Find Accounts Window]

• Once the “Account” field is populated, click on the “Show Balances” button.

![Show Balances Window]
• Once the “Detail Balances” window is open, click on the “Journal Details” button.

![Image of Detail Balances window]

• Once the “Journals (RIT)” window is open, click on the “Drilldown” button.

![Image of Journals (RIT) window]

The Drilldown button takes you into the Accounts Payable Oracle application in order to view the invoice information. The “View Journal Entry Lines” screen opens in a browser window. This screen shows a line for each item included on the invoice and the amount paid for each item that add up to the total amount charged.

From this screen you can click on the “View Transaction” button to drill down to the “Invoice Workbench” to view the Payables information, (Supplier, PO and Invoice...
number), detail behind a transaction, view the journal entry for a transaction or export the detail to Excel.

- In the “View Journal Entry Lines” (RIT) page, select the circle in the “Select” column
- Click on the “View Transaction” button right above the “Accounts Description” column.

The Invoice Workbench form is displayed on his screen. The browser window is no longer necessary and can be closed.

After clicking on the “View Transaction” button, the Advanced Search screen is replaced by an Oracle e-business suite screen in your browser window. In the background Oracle has opened up the **Invoice Workbench** form within the Applications.
In the upper section of the “Invoice Workbench” screen you can see that the PO Number is 169763, the Supplier name in the “Trading Partner” field is “FISHER SCIENTIFIC”, the Supplier number in the “Supplier Num” field is “1785”, the Supplier Site is “ACCT # 705716-0”, the Invoice date is “01-MAR-2016”, and the Invoice number in the “Invoice Num” field is “8741579”.

In the lower section of the “Invoice Workbench” screen there are six tabs that provide Invoice, Purchase Order and Payment information.
• On the **1 General** tab and you will see that the total invoice in the amount of $6,534.17 has been fully paid.

• Click on the **2 Lines** tab you will again see the PO Number 169763, the Quantity ordered for the purchase, and a left – right scroll bar.

• Using the scroll bar, scroll to the right you will see the unit prices and item descriptions.
NOTE: Tab “3 Hold”. If a check has been processed but an issue arises prior to payment (e.g. matching the invoice to the PO) then AP will not release it until the process has been completed. For more information contact Accounts Payables email: accpay@rit.edu ext. 55580.

- Click on the “4 View Payments” tab and you will see the check number. If the payment was made via wire, that would

- Click on the “Payments Overview” button to see the dollar amount of the check, if / when the check cleared, the address payment was sent, and the invoice(s) paid on that check.
• Click on the “X” in the top right hand corner to close the window and bring you back to the “Navigator” form in the application. Close all other windows.

**NOTE:** If the payment you are inquiring on is Electronic then the supplier’s Address field on the Payment Overview screen will be blank.

**Summary of Steps to Perform an Account Inquiry:**

1. Log on to the Oracle applications and select the “RIT – GL – REPORT & INQUIRY” responsibility from your list of responsibilities on your home page.
2. From the “Inquiry” menu listed to the right of the list of responsibilities, click on “Account”.
3. The Account Inquiry screen will appear, with the cursor blinking in the “Name” field of the “Ledger/Ledger Set” section. Press the tab key to move the cursor to the “From” field in the “Accounting Periods” section. The system will automatically display the current accounting period in both the “From” and “To” fields.
   • If you would like to select a different accounting period, place your cursor in the field you would like to change. Click once on the LOV field to the right of the “From” and “To” fields. In the list of values that appears, click once to highlight your selection and click on the “OK” button.
4. The system will automatically fill in the values for “Currency Type”. Press the Tab key to arrive at the middle portion of your screen.
5. “Actual” is the default select under Primary Balance. Hit your Tab key (unless you would like to select another Balance Type).
6. Tab over the “Factor” and “Summary Template” fields on your screen, until you arrive at the Accounts area of the screen.
7. When the Find Accounts screen appears, enter your 24-digit account number in the “Low” column.
   - If you would like to query a range of accounts, you can enter two different values in the “High” and “Low” columns in this screen.
8. Click on the “OK” button. This brings up the Account Inquiry (RIT) screen.
9. In order to review the balance on any of the accounts listed, click on the box next to the account number.
10. Click once on the “Show Balances” button.
    - If the screen does not reflect all of the fields you are interested in viewing, click once on the Folder Tools icon on the Toolbar.
    - Click once on the Show Field icon in the Folder Tools screen.
    - Make your selection from the list of field values that appears by clicking once on it.
    - Click on the “OK” button.
    - To return to the original view, click once on the Hide Field icon on the Folder Tools screen.
11. To print the account balance screen, go to the Menu Bar.
    - Click on “File”
    - Click on “Print”
    - When the Print screen appears, select your desktop printer and click on “OK”.
12. To review an individual journal that makes up the balance on the account, click once in the “PTD” column in the first row to select it.
13. Click once on the “Journal Details” button. This brings up the Journals (RIT) screen, listing all of the entries in the selected journal.
14. To view journal entry detail click on the “Show Full Journal” button to view the actual journal entry.
15. To view the history of this entry, click once on “Help” in the menu bar at the top of this screen.
    - Select “Record History” and click on it. The Record History screen opens.
    - Click on “OK”
16. In order to examine a specific invoice from Accounts Payable, click once on the first field in the row containing Payables Purchase Invoices in the Journals (RIT) screen to select it.
17. Click once on the “Drilldown” button to go into the “View Journal Entry Lines” screen which will open in a new browser window.
18. From this screen click on the “View Journal Entry” button to view the journal entry or the “Export” button to export the details on this screen to Excel.
19. Click on the “View Transaction” button to view the “Invoice Workbench” screen which provides you with transaction details such as Supplier, PO number, and
Invoice number. The Oracle e-business suite browser window can be closed at this time.

20. In the upper section of the Invoice Workbench screen you can see the Supplier name, Supplier number, Supplier Site, Invoice date and the Invoice number.

21. In the lower section of the “Invoice Workbench” screen there are six tabs that provide Invoice, Purchase Order and Payment information.

22. Click on the “Lines” tab to see item descriptions and the Purchase order number.

23. Click on the “View Payments” tab and then the “Payments Overview” button.
   From the “Payments Overview” screen you can see whether the check has cleared the bank and on what date.

24. To return to the Account Inquiry screen from the Payables screens, click on the Close box in the upper right corner of each screen.
Reports – Definitions

The Oracle Financial Applications can be used to request various financial reports that you can view on your desktop or print at your networked printer. There are two different types of reports that you can request.

- **FSG (custom) Reports** (includes monthly department or project statements): These reports generated by the Financial Statement Generator are designed to help you track your department’s budget, revenues and expenditures over a period of time, usually one month. Since only summary balances are reflected on statements, they give managers a high-level view of their operating or project accounts.

- **Standard Reports**: These reports contain transaction detail to assist you with reconciling financial activity for your department or project.

The Controller’s Office expectation for department’s performing due diligence to manage budgets and projects is for a monthly review of all transactions both high level comparisons of actual to budget and also detailed transaction reconciliation.

For questions regarding running and viewing reports, contact Accounting Operations email: acctg@rit.edu ext. 5-2237.

**NOTE 1**: Workshop #7 in the “Accounting Practices, Procedures, and Protocol” training series “Using Oracle Reports to Reconcile Your Budget” accompanies this training module. It is offered on specific dates during the fiscal year and is recommended that first-time users attend.

**NOTE 2**: Refer to the Appendix at the end of these materials for more information about FSG and Standard Reports available to Oracle users including report names, descriptions and the purpose of each report.

**NOTE 3**: Contact the Helpdesk (ext. 5-HELP) or a technical support person in your area if you experience technical issues with running Oracle reports.

**NOTE 4**: Contact Accounting Operations if you have any questions regarding the data output on your reports. Email: acctg@rit.edu; ext. 5-2237
Lesson 2: Run an FSG Report using the Publish FSG Report Program

The “Program - Publish FSG Report” feature gives you the option to publish your reports in the following formats: PDF (the default), Excel, or HTML. Using this feature allows you to run your FSG reports without having to connect to a printer in the Oracle printer network.

Objective:
In this lesson you will learn how to create and run a statement using the “Publish FSG Report” function.

Directions: Request an FSG Report

- At the “RIT – GL – COS RPT & INQ – 67000-67099” Navigator screen, make sure “Reports” is highlighted. Click on “Open”.

- Select “Single Request” and click the “OK” button.
• In the “Submit Requests” window click on the LOV field to the right of the “Name” field.

• In the “Reports” screen that appears, click on “Program-Publish FSG Report”.
  • Click on the “OK” button.

• Complete the “Parameters” window with the following information:
  o Report: RIT- Dept Statement
  o Period: JUN-15
  o Click on the Segment Override and enter: Dept:67000; project:00000
NOTE: The data keyed into the Segment Override must be accurate in order to get the correct output.

- Click the “OK” button.

- Back into the “Parameters” window click the “OK” button.
The Submit Requests screen appears on your terminal.

- Click on the “Options” button within the “Upon Completion…” section.

- Place your cursor in the “Format” field in the “Layout” section of the “Upon Completion” screen.
You have the option to format these reports in PDF, Excel, or HTML. Since the format defaults to PDF, if you decide to save the report in that format then skip this step.

- The “Format Type LOV” screen opens, select “Excel” and click the “OK” button.

- Click on the “OK” button.
• Click on the “Submit” button.

• Click on the “Refresh” button.
• Click on the “View Output” button.

The report opens up in Excel within a new browser window. From the “File” menu’s drop down list, Sam selects “Save As…”

• Click on “File” and select “Save As…” from the drop down menu.
• Save the report in a folder on one of your department’s shared drive.
Summary of Steps to Request an FSG Report using the Publish FSG Report Program

1. When the Submit Request screen opens the “Single Request” option will be automatically selected. Click the “OK” button.
2. The Submit Request screen will open. Click on the LOV field located to the right of the “Name” field. The Report screen comes into view.
3. Click on “Program – Publish FSG Report” to be able to publish your report to Excel.
4. Click on the “OK” button. The Parameters screen will appear.
5. Press the Tab key once to get to the “Report” field.
6. With your cursor blinking in the “Report” field, click on the LOV field located to the right of the “Report” field. The Reports screen will appear.
7. Type “RIT-%” in the “Find” field and click on the “Find” button.
8. The Parameters screen will reappear, with the “Period” field highlighted.
9. The system automatically defaults to the current accounting period. If you would like to view your department statement for a different period:
   • Making sure the “Period” field is highlighted, click on the LOV field to the right of the “Period” field.
   • A Period screen will appear. Scroll down to view the desired period. Click on your selection.
   • Click on the “OK” button to return to the Parameters screen.
10. Press the Tab key until the Chart of Accounts screen appears. Enter the department number in the “DEPARTMENT” field for the statement you wish to view using a project of “00000”.
    • To request statements for a range of departments, tab past the “Segment Override” field.
11. Click on the “OK” button. This returns you to the Parameters screen.
12. Click on the “OK” button.
13. Click on the “Options” button in the “Upon Completion…” section to change the format of your report.
14. In the Upon Completion screen, place your cursor in the “Format” field in the “Layout” section. Select “Excel” from the drop down menu.
15. Click the “OK” button to return to the Submit Request screen.
16. Click the “Submit” button to submit your “Publish FSG Report” request.
17. Once your request has completed, click on the “View Output” button in the Requests screen. The report output will publish in Excel within a browser window. From here you can save the report to your server.
Lesson 3: Request an FSG Report using the Run Financial Statement Generator program

Another option available to you is to run your report using the function.

Objective:
At the end of this lesson, you will be able to request and print a department statement using the program “Run Financial Statement Generator.

Directions: Request an FSG Report

- At the “RIT – GL – COS RPT & INQ – 67000-67099” Navigator screen, make sure “Reports” is highlighted. Click on “Open”.

- Click the “OK” button.
• Click on the LOV field to the right of the “Name” field.

In the Reports screen that appears, click on “Program-Run Financial Statement Generator”.

• Click on the “OK” button.
• Click on the LOV field to the right of the “Report” field.

• Type “RIT-%” in the “Find” field.
• Click on the “Find” button.
NOTE: Since NTID has a different fiscal year and budget organization than RIT, NTID departments use a different monthly statement. It is called the “NTID–Dept Stmt”. NTID employees would select this report from the list rather than “RIT–Dept Statement”. The following steps are the same regardless of the report selected.

- Select the “RIT-Dept Statement” report and click the “OK” button.

- With the “Period” field highlighted, click on the LOV field to the right of the “Period” field. A Period screen will appear.
- Use the scrollbar at the right of this screen to scroll down to “DEC-07”.
- Click on it to select it.
- Click on the “OK” button.
NOTE: If you want to request department statements for all departments within your responsibility, tab past the “Segment Override” field. Security rules will allow you to run department statements for only those departments that you are authorized to access.

- Press the Tab key twice. The Chart of Accounts dialog box will appear on your screen.

- Press the Tab key twice.
- With your cursor blinking in the “Department” field in the Chart of Accounts screen, type “67000”.
- Place your cursor or tab to the “Project” field, type “00000”.
- Click on the “OK” button.
• The remaining fields are not used. Click on the “OK” button.
You have now learned how to request a FSG report such as your Department Statement. In the next lesson you will learn how to print your report to your Oracle networked printer.

**Summary of Steps to Request an FSG Report using the Program Run Financial Statement Generator Program**

1. When the Submit Request screen opens the “Single Request” option will be automatically selected. Click the “OK” button.
2. The Submit Request screen will open. Click on the LOV field located to the right of the “Name” field. The Report screen comes into view.
3. Select the “Program – Run Financial Statement Generator” from the list of values.
4. Click on the “OK” button. The Parameters screen will appear.
5. Press the Tab key once to get to the “Report” field.
6. With your cursor blinking in the “Report” field, click on the LOV field located to the right of the “Report” field. The Reports screen will appear.
7. Type “RIT-%” in the “Find” field and click on the “Find” button.
8. The Parameters screen will reappear, with the “Period” field highlighted.
9. The system automatically defaults to the current accounting period. If you would like to view your department statement for a different period:
   - Making sure the “Period” field is highlighted, click on the LOV field to the right of the “Period” field.
   - A Period screen will appear. Scroll down to view the desired period. Click on your selection.
   - Click on the “OK” button to return to the Parameters screen.
10. Press the Tab key until the Chart of Accounts screen appears. Enter the department number in the “DEPARTMENT” field for the statement you wish to view using a project of “00000”.
   • To request statements for a range of departments, tab past the “Segment Override” field.
11. Click on the “OK” button. This returns you to the Parameters screen.
12. Click on the “OK” button.
13. You will return to the Submit Request screen.

Quick Review
You have just learned how to request a department statement for one department or a range of departments. You are now ready to print this statement on a networked printer.
Lesson 4: Email and Print an FSG Report on a Networked Printer

Once you have requested an FSG report using “Program – Run Financial Statement Generator”, you can print it on a networked printer (that is set up to print Oracle reports), and view the output on your computer screen.

Objective:
At the end of this lesson, you will be able to view your report on your computer screen, e-mail a report notification automatically and print your department statement at your networked printer.

NOTE: If there is a printer in your department that you would like to print Oracle reports on, call the ITS Help Desk at ext. 5-4357.

Directions: Print an FSG Report

- Click on the “Options” button within the “Upon Completion” section.

NOTE: Refer to the Appendix Tip #4, to find out how to schedule a report in the “At these Times…” section.
• Click on the LOV field located to the right of the “Name” field in the “Upon Completion” screen.

• Enter the name of the person and click on the “Find” button.
• Select the person’s name and click on the “OK” button.

• Click once within the “Printer” field to position your cursor in the “Printer” field.

• Click on the LOV field to the right of the “Printer” field. The Printers screen appears.

• In order to reduce the list of printers, type “prcto%” in the ‘Find’ field and click the “Find” button. The printer “prcto01_app” is the second one on the list. Click on it to select it. Click on the “OK” button.
• In the “Copies” field, enter the number of copies you would like to print.

• Click on the “OK” button.

• Click on the “Submit” button. (Remember, since we left a “0” in the “Copies” field of the Options screen, we won’t actually be printing our report).
• Click on the “Refresh Data” button.

NOTE 1: The “Cancel” and “Hold” buttons are only active when a request has not yet completed.

NOTE 2: Another way to refresh the data on your “Requests” screen is to hold down the Control key and press the F11 key.

NOTE 3: In this example notice Request ID 2530466 “Phase” Completed “Status” Warning. This will always occur if the report you ran has no data. In this case, view your output and check the parameters you entered. Submit a new report with the correct parameters. For questions contact Accounting Operations email: acctg@rit.edu Ext. 5-2237
• Select your second request id and click on the “View Output” button.

• Click on the maximize box in the new browser window to maximize the window.
• Click on the close box in the browser window to close the window.

• Click on the “Submit a New Request” button.
• Click on the “OK” button.

• Click on the “Copy” Button.

• Find the report you want to copy
• Place your cursor in the “Parameters” field and make necessary changes

**Example of changes:**

• Click in the “Period” field.
• Click on the LOV field to the right of the “Period” field.
• Select “NOV-07” and click the “OK” button.
• Click on the “OK” button in the “Parameters” field.
• Submit the report for printing.
NOTE: To view prior requests from the Navigator screen click on the “View” menu and select “Requests”. A “Find Requests” screen will open giving you the option to specify which request ID you want to find or if you want to find all of your requests simply click the “OK” button.

NOTE: You can also change the order your requests display in the “Requests” screen by using the “Order By” field in the “Find Requests” screen. You can put them in order by Request ID, Name or by Requesting Start Date.
The following screen shows the list of Request ID numbers in descending order.
Summary of Steps to Print an FSG Report from a Networked Printer

1. In the “Submit Request” screen click on the “Options” button.
2. To send an e-mail notification place your cursor in the “Name” field within the “Notify the following People;” section on the “Upon Completion” screen.
   - Click on the LOV field to the right of the “Name” field.
   - Type the employee’s last name and a percent sign in the “Find” field.
   - Click on the “Find” button.
   - Select the employee’s name from the reduced list of values.
   - Click on the “OK” button.
   - Repeat for as many employees that you want to e-mail.
3. To select a printer and number of copies place your cursor in the “Printer” field within the “Print the Output To:” section on the “Upon Completion” screen.
   - Click on the LOV field to the right of the “Printer” field.
   - If you know the printer’s name, type it in the “Find” field (or part of it with a percent sign).
   - Click on the “Find” button.
   - Select the printer’s name from the reduced list of values.
   - Click on the “OK” button.
   - The cursor will automatically tab to the “Copies” field. Enter the number of copies you want to print.
   - Repeat for as many printers as you need.
4. Click on the “OK” button. The Submit Requests screen reappears.
5. Click on the “Submit” button.
6. The “Requests” screen automatically opens with your request id highlighted in blue.
7. If the phase of your job is pending or running it will be highlighted in green until it is completed. If your job errors out it will be highlighted in red.
8. Follow along the row in which your request id appears to view its phase and status in the print queue. You must also check the request id for the “Financial Statement Generator” which is a second request generated by the first. This is the request that will create your report.
9. When the phase and status are “Completed” and “Normal” for the two jobs you can view the report online. Select the second request id and click on the “View Output” button.
10. To make your output screen larger click the maximize button in the upper right hand corner.
11. Use the scroll bar to scroll down and view the other pages in your report.
12. Close your output screen by clicking on the close box in the upper right corner.
13. You can submit a new request from the “Requests” screen by clicking on the “Submit a New Request” button. The “Submit a New Request” screen will open.
14. By clicking the “OK” button you will be taken to the “Submit Request” screen where you can create a new request or copy a previous request by clicking on the “Copy” button.
15. When you copy a previous request you can change the parameters (period, segment override, etc.) by clicking in the “Parameters” field. The parameters screen will open, allowing you to change the parameter values.

16. To view requests directly from the Navigator window click on the “View” menu and select “Requests”.

17. The “Find Requests” screen will open. From there you can enter a specific request id to find, or change the order in which your requests display. Click the “OK” button to go to the “Requests” screen.
Lesson 5: Request a Standard Report RIT Account Analysis - Subledger

Directions: Request a Standard Report

Objective:
In this lesson you will learn how to create and run the “RIT Account Analysis – Subledger” report.

NOTE: This report provides the transaction detail for all of the object codes listed on your department and project statements for a period. Use this report to reconcile your monthly transaction detail and use the information as supporting documentation for all manual journal entries.

- At the “RIT – GL – COS RPT & INQ – 67000-67099” Navigator screen, make sure “Reports” is highlighted.
- Click on “Open”.

![Image of Navigator screen with RIT Account Analysis report selection]
• Click on the LOV in the “Name” field.
• Select the “RIT Account Analysis – Subledger” report.

![Image of the LOV window]

• Enter the Accounting Period(s) you want to see transaction detail.

![Image of the Parameters window]

• Enter the Account information in the RIT CHART OF ACCOUNTS window then click the “OK” button.
NOTE 1: By entering values 00 – ZZ for the ENTITY, OBJECT, and EXPENSE CATEGORY, you are able to check to see if a transaction was posted to an incorrect combination. This creates a more efficient reconciliation.

NOTE 2: This report will only provide summary information for payroll expenses. Detail is available by running the “Payroll Distribution Report”. This report is only available to users who have a responsibility RIT – GL – RPT, INQ & PRL. For more information on running Payroll Distribution Reports, contact the Payroll Office at ext. 5-5580 or 5-6984

- Click on the “OK” button to open the “Submit Request” window.

NOTE 3: The PDF, HTML or Excel formats can be used to view and print this report. The right one to choose depends on personal preference and reporting needs. PDF is the default format. If this is your choice then skip this step and submit your report.

- From the “Submit Request
- Click on the “Options” button.
Click in the “Format” column of the “Layout” section.
Click on the LOV field.
From the drop down list select either Excel or HTML

Click the “OK” button in the “Upon Completion…” window to submit to the “Submit Request” window.
• From the Submit Request Window click on the “Submit” button.

• Click the “Refresh Data” button.
• Once the report is “Completed”, click on the “View Output” button
Below is an excerpt from the report you just ran.

Below is an example of payroll entries (note the “Line Descr/Commitment” column)
Summary of Steps to Request and Print the
RIT Account Analysis – Subledger

1. In the Navigator screen, make sure “Reports” is highlighted. Click once on “Open”. This will bring up the “Submit a New Request” screen.
2. Press the “OK” button to request a single request and open the “Submit Request” screen.
3. Click once on the LOV field to the right of the “Name” field. The Reports screen appears.
4. Click once on your selection, choosing one of the reports in the list of values.

RIT Account Analysis – Subledger
- The Parameters screen appears.
- With your cursor positioned in the “Period From” field, click on the LOV field to the right of the “Period From” field.
- Click on the period you wish to start with.
- With your cursor positioned in the “Period To” field, click on the LOV field to the right of the “Period To” field.
- Click on the period you wish to end with.
- Click on the “Account Flexfield From” field. In the “Chart of Accounts” window, enter the range of accounts you want to see the detail.
- Click on the “OK” button to populate the “Account Flexfield From” and Account Flexfield To” fields.
- Your cursor will move to the “First order by” field, which defaults to “Department”.
- If you want to have the report sort and page break by project number, select “Project” from the LOV.
- The RIT Account Analysis – Subledger report will not print from a networked printer.
- If running the RIT Account Analysis – Subledger report you can change the report layout format by clicking on the “Options” button in the “Submit Request” window.
- In the “Layout” section place your cursor in the “Format” column and click on the LOV field to select a PDF, HTML or EXCEL format.
- Skip over the “Print Output To:” section and click on the “OK” button.
Lesson 6: Request a Standard Report
RIT Encumbrance Detail Report (XML)

Objective:
In this lesson you will learn how to create and run the “RIT Encumbrance Detail Report. Use this report to reconcile your open purchase orders monthly.

NOTE: You must reconcile all open Purchase Orders on a monthly basis.

- At the “RIT – GL – COS RPT & INQ – 67000-67099” Navigator screen, make sure “Reports” is highlighted.

- Click on “Open”

- In the “Submit a New Request” the “Single Request” option should be selected. Click on the “OK” button.
• Select the “RIT Encumbrance Detail Report” from the list of reports and click the “OK” button once

• Click on the “Accounts From” field
• Enter the following account information in the “RIT Chart of Accounts” Window
• Click “OK”

NOTE 1: **You must enter account information** otherwise you will receive an open PO report for the entire Institute.

NOTE 2: Since Procurement Services and Account Payables enter and pay Purchase Orders on a daily basis, **do not enter Encumbrance Date information**. The purpose of the RIT Encumbrance Detail Report is to allow you to view the most recent Purchase Order information.

• Click the “OK” button to submit the report
• Click the “Submit” button once

• Click on the “View Output” button

• Select “File” -> “Print
NOTE: There are two other versions of this report available to you: (1) The “Encumbrance Detail Report” shows the P.O.# and encumbrance information but does not provide the name of the vendor, (2) “RIT Encumbrance Detail Report” is the same report as the “XML” version but the default output is PDF.

Summary of Steps to Request and Print the RIT Encumbrance Detail Report (XML)

1. In the Navigator screen, make sure “Reports” is highlighted. Click once on “Open”. This will bring up the “Submit a New Request” screen.
2. Press the “OK” button to request a single request and open the “Submit Request” screen.
3. Click once on the LOV field to the right of the “Name” field. The Reports screen appears.
4. Click once on your selection, “RIT Encumbrance Detail Report (XML)”
5. In the “Parameters” window, enter the account parameters using the “Chart of Accounts” located in the “Accounts From” and “To” fields **Do not enter any other parameter information.**
6. Click on OK to submit the report for printing
7. Click once on “View Output” once the report has generated.
8. Print and/ or save the file.

Options
Choose either the “Encumbrance Detail Report” or the “RIT Encumbrance Detail Report” to print directly through the Oracle print network
Summary

This ends the practice exercises. You have covered all of the available options when using Oracle Financial Applications to make an account inquiry and to request and print department or project statements and selected standard reports. If you have any questions, ask the instructor now.

*Please contact the Senior Staff Accountant/Outreach Specialist at ext. 52237 for all questions related to running FSG and Standard reports.*
## Appendix: Oracle FSG Reports

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RIT– DEPT STATEMENT</strong></td>
<td>Current fiscal YTD &amp; PTD Permanent &amp; Working Budget,</td>
<td>To give department managers a high-level view of their current YTD RIT operating account expenditures as compared to their Permanent &amp; Working budget at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR ALL RIT DEPARTMENTS WHEN PROJECT = 00000)</td>
<td>Encumbrance and Actual totals for revenue and expense categories in RIT operating accounts (project = 00000).</td>
<td></td>
</tr>
<tr>
<td><strong>CAPITAL EQUIPMENT STATEMENT</strong></td>
<td>YTD &amp; PTD Encumbrance and Actual totals for Capital Equipment Accounts.</td>
<td>To give department managers a high-level view of their Capital Equipment account expenditures at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR ALL DEPARTMENTS WHEN PROJECT = 84200 or 84370)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>RIT PLANT FUND CAPITAL-PROJ</strong></td>
<td>PTD, YTD &amp; PJTD (project-to-date), Actual totals for revenue and expense categories in Capital projects.</td>
<td>To give department managers a high-level view of only their department’s Capital project expenditures, not to be used with Physical Plant departments.</td>
</tr>
<tr>
<td>(USE FOR ALL DEPTS WHEN PROJECT = 82000 – 83999 &amp; 85000 - 89999)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SPA GRANTS STATEMENT</strong></td>
<td>PJTD &amp; PTD Budget, Encumbrance and Actual totals for Grant/Contract projects.</td>
<td>To give Principal Investigators a high-level view of their grant/contract expenditures as compared to their budget at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR ALL DEPARTMENTS WHEN PROJECT = 30000-39999)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>OTHER PROJECTS STATEMENT</strong></td>
<td>YTD &amp; PTD Budget, Encumbrance, and Actual totals for Special Projects, Designated Funds, Gifts, and Endowment Earnings projects.</td>
<td>To give department managers a high-level view of their Special Projects, Designated Funds, Gifts and Endowment Earnings projects at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR ALL DEPARTMENTS WHEN PROJECT = 10000-79999, EXCLUDING 30000-59999)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>NTID – DEPT STMT</strong></td>
<td>FY 2XXX YTD &amp; PTD Budget, Encumbrance, and Actual totals for Revenue and Expense categories in NTID Operating accounts.</td>
<td>To give NTID department managers a high-level view of their current YTD operating expenditures as compared to their budget at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR DEPARTMENTS 40000-49999, WHEN PROJECT 02000 ≥ 03099)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>IT– AUX STMT</strong></td>
<td>Current fiscal YTD &amp; PTD Permanent &amp; Working Budget,</td>
<td>To give department managers a high-level view of their current YTD Auxiliary account expenditures as compared to their Permanent &amp; Working budget at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR ALL DEPARTMENTS 20000-29999 WHEN PROJECT = 00000)</td>
<td>Encumbrance, and Actual totals for revenue and expense categories for Auxiliary Departments. Benefits and ITS charges are not broken out separately.</td>
<td></td>
</tr>
<tr>
<td><strong>AGENCY PROJECT STATEMENT</strong></td>
<td>YTD &amp; PTD Budget, Encumbrance, and Actual totals for Agency Fund projects.</td>
<td>To give department managers a high-level view of their Agency Fund project expenditures at a given point in time.</td>
</tr>
<tr>
<td>(USE FOR ALL DEPARTMENTS WHEN PROJECT = 90000-99999)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HIERARCHICAL REPORT</strong></td>
<td>YTD Budget and Actual totals by revenue and expenses for RIT operating accounts by college or division.</td>
<td>To give Deans and Division heads a high-level view of their RIT operating revenue and expense categories for departments reporting in their college or division.</td>
</tr>
<tr>
<td>(USE FOR ALL RIT DEPARTMENTS WHEN PROJECT = 00000)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Appendix: Oracle Standard Reports

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RIT Account Analysis - Subledger</strong></td>
<td>Detail of transactions by period, sorted by department or project then by object code. There is a page break after each department or project depending on the sort order.</td>
<td>To provide additional information regarding revenue payments received and payments made to suppliers including supplier name and invoice number.</td>
</tr>
<tr>
<td><strong>General Ledger – Detail</strong></td>
<td>Detail of account activity by period, including beginning and ending balance for each 24-digit account number.</td>
<td>To provide detail information for asset and liability account reconciliations.</td>
</tr>
<tr>
<td><strong>Journals – General (180 Char)</strong></td>
<td>Detail of all journal entries within a batch in journal entry number order.</td>
<td>To provide journal entry detail to assist with account reconciliations.</td>
</tr>
<tr>
<td><strong>Encumbrance Detail Report</strong></td>
<td>Detail of encumbrance activity by a range of dates, for a range of accounts and vendors.</td>
<td>To provide encumbrance detail information on open Purchase Orders to assist with account reconciliations.</td>
</tr>
<tr>
<td><strong>RIT Encumbrance Detail Report</strong></td>
<td>Detail of encumbrance activity by a range of dates, for a range of accounts and vendors.</td>
<td>To provide encumbrance detail information on open Purchase Orders (including Vendor Name) to assist with account reconciliations.</td>
</tr>
<tr>
<td><strong>ITS Chargeback Employee Detail Report</strong></td>
<td>ITS Chargeback detail including employee name, FTE and payroll date by account number.</td>
<td>To provide detail information for ITS Chargebacks to assist with account reconciliations.</td>
</tr>
<tr>
<td><strong>ITS Chargeback Student Detail Report</strong></td>
<td>ITS Chargeback detail including student id, FTE and college program code by dept number.</td>
<td>To provide detail information for ITS Chargebacks to assist with account reconciliations.</td>
</tr>
</tbody>
</table>
TIP #1: How to Default Your Printer Name

1. In the Navigator screen double click on the “Other” menu option, and then on “Profile”.

2. Under the “View / Query By Example” menu click on “Enter”.

---

[Diagram of the Navigator screen and the View / Query By Example menu]
3. In the “Profile Name” field type “Prin%”.

4. Under the “View / Query By Example” menu click on “Run”.

5. Place the cursor in the first field in the “User Value” column.
6. Click on the “List of Values” field to the right of the “User Value” field. Select your Printer’s name from the list.
7. Click on the “Save” icon on the tool bar to save the settings.
TIP #2: Reprint Function

1. Occasionally you may want to reprint a report that you recently requested.
2. In the Navigator screen click on the “View” menu and select “Requests” to go to the “Requests” screen.

NOTE: this process is only for reports that print through the Oracle print network.

3. When the “Find Requests” screen opens click the “Find” button.

4. In the “Requests” screen select the request id you want to reprint, click on the “Tools” menu and select “Reprint”.

Oracle Training: Performing Inquiries and Requesting Reports in the Oracle Applications
Revised October 2017
5. The “Republish and Reprint Request” window will open in a new browser window.
6. If you selected a printer when you originally submitted this request, it will show in the “Printer” field. If not or if you want to change the printer click on the LOV button to the right of the “Printer” field.

7. The “Search and Select: Printer” window will open. In the “Search” section type in the first few letters of the printer name you want to find, and put a “%” sign after, then click on the “Go” button.
8. A list of printers will show in the “Results” section. Click in the “Select” column to the left of the printer name you want to select. Click on the “Select” button in the upper right hand corner of the screen.

9. In the “Republish and Reprint Request” window press the Tab key four times to tab to the “Copies” field. Enter the number of copies you want to print.
10. Click on the “Apply” button.

11. To confirm your reprint request, click on the “OK” button in the “Republish” section.
12. The “Republish and Reprint Request” window will not close automatically. Click on the “Close Window” link at the bottom of the page to close this window.
TIP #3: How to Schedule a Report

1. To schedule a report to run at a designated time click on the “Schedule” button in the “Submit Request” screen when requesting the report.

2. The “Schedule” screen will open giving you the option to run the job:
   - As Soon as Possible – right away
   - Once – You pick a date and time for the report to run only once.

   - Periodically – Select a start and end date, how often you want the report rerun (monthly, weekly, daily, hourly or once every minute), and if you want the report to start at the same time as the previous one or at the time the previous
one ended. If your request contains date parameters, you can choose "Increment date parameters each run" to have the value for that parameter be adjusted to match the resubmission interval. For example, if the value for the parameter is 25-DEC-2007 07:00:00 and your interval is monthly, the parameter is adjusted to 25-JAN-2008 07:00:00 for the next submission.

- On Specific Days – You can pick multiple dates within a month or the same days every week for a designated time frame.

- You can use a schedule that already exists by clicking on the “Apply a Saved Schedule” button and picking from a list of values to use a pre-defined schedule.
Appendix 2: Additional Reference Information (Controller’ Website)

Month-End Closing Schedule
Monthly Closing Schedule

Oracle Financial Applications FAQs
https://www.rit.edu/fa/controller/oracle

Oracle Training
https://www.rit.edu/fa/controller/content/training

Single Sign-On and MFA (Multi-factor Authorization)
https://www.rit.edu/security/content/mfa-multi-factor-authentication